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SAP2000 v24.2.0 Release Notes
© 2023 Computers and Structures, Inc.

Notice Date: 14-February-2023

This document lists changes made to SAP2000 since v24.1.0, released 11-October-2022. Items marked
with an asterisk (*) in the first column are more significant.

Analysis
Enhancements Implemented
* Ticket Description

9094 The following enhancements have been made to the analysis messages, as shown in the
Analysis .LOG file, the Analysis Messages form, and the table "Analysis Messages": (1.) The
affected element type and element name are now given whenever applicable. (2.) The
Windows system error message text is now given for file IO errors. (3.) The “Results deleted”
informational messages are no longer shown for either user-initiated or internal operations
that would cause the results of a load case to be deleted. These messages were correct, but
sometimes caused confusion, when load cases were automatically re-run due to an iterative
process like finding the structural period to use for auto-wind or auto-seismic load cases.

9223 The Analysis Monitor form has been enhanced for running load cases in parallel so the now
the Summary tab displays the Run Tag and the Status of completed load cases (e.g.,
“Finished”, “Not Finished”, “Could not Start”, etc.), making it possible to easily identify load
cases that didn’t complete while the analysis is still running or after it is done.

API
Enhancements Implemented
* Ticket Description

9013 An enhancement has been made to the Application Programming Interface to add new
functions cAutoSeismic.GetASCE716 and cAutoSeismic.SetASCE716 for the ASCE 7-16 auto-
seismic loading.

9023 Two related enhancements for the Application Programming Interface (API) were
implemented. (1) New functions PropFrame.GetTube_1 and PropFrame.SetTube_1 were
added. These are similar to PropFrame.GetTube and PropFrame.SetTube, but they accept an
additional argument corresponding to the corner radius of the tube section whose
dimensions they retrieve or set. (2) Functions GetInsertionPoint_1 and SetInsertionPoint_1
were documented in the CSI_OAPI_Documentation.chm file. These had been available in
previous versions but not documented. They are similar to GetInsertionPoint and
SetInsertionPoint but they accept an additional argument corresponding to the Mirror about
Axis3 flag of the frame objects whose insertion points they retrieve or set.

9219 A new API example for the IronPython programming language has been added to the
CSI_OAPI_Documentation.chm file. In addition, the Python (COM) and Python (.NET)
examples have been updated to work with the latest versions of Python and their required
packages.
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Data Files
Enhancements Implemented
* Ticket Description

9075 Minor corrections have been made to the Chinese frame-section database file
ChineseGB08.xml. These include (1.) Changing section name YB-WH700X300X12X38 to YB-
WH700X300X12X28, with the corresponding change in flange thickness, and (2.) Minor
changes to the section moduli of several sections. No section property values affecting
analysis were changed, and the effects on design properties is insignificant. These changes
only affect models that import these properties from the new database file. Models that
imported properties from an earlier database file will not be affected. This new Chinese
frame-section database file was previously included in the Chinese installation for SAP2000
v24.1.0, but is new for the the regular installation of present release v24.2.0.

Database Tables
Enhancements Implemented
* Ticket Description

9205 An enhancement has been implemented to include the program name, program version,
and the version for each table in the export of table and field keys to the XML file from
within the software. Additionally, the menu command for this export has been changed to
"Options > Database > Write Table and Field Keys to XML File" to better reflect the
information being exported. Previously, the command was "Options > Database > Write
Default Table Names to XML". The resulting XML file as applied to all possible tables is now
automatically included in the installation folder. This can be compared between versions of
the software to see which tables have been changed. This information can be used to
update programs and scripts that work with exported/imported database tables or API
applications that use the table functions for editing and/or display.

Design – Concrete Frame
Enhancements Implemented
* Ticket Description

8777 An enhancement has been made to the concrete beam design code "Eurocode 2-2004" in
which the tan(theta) is now optimized for DCM and DCL frames per EN 1998-1:2004 even
where there is a seismic load. Previously, tan(theta) was not optimized for cases with
seismic load irrespective of framing type. It is still taken as 1 for DCH beams with a seismic
load. The previous results were slightly conservative. Also, because of tolerance issues, and
only on rare occasions, the design could show shear failure when the tan(theta) was
optimized for non-seismic cases. This latter issue is also fixed.

* 9150 An enhancement has been made to concrete frame design to add a new crack-width
(serviceability) design or check according to Eurocode 2-2004 and Italian NTC 2008 codes.
This feature is available for beam (M3) design and for the design or check of column
reinforcement. The crack width, concrete stress, and steel stresses are calculated and
compared against the limits imposed by the Eurocode 2-2004. The design/check results are
displayed in the right-click design detail report, display design info, and database tables. The
feature is currently limited to prismatic frame sections only.

Design – Concrete Shell
Enhancements Implemented
* Ticket Description

9329 An enhancement has been made to the Display Concrete Shell Design Results form to
include an option to display the results on the deformed shape.
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External Import and Export
Enhancements Implemented
* Ticket Description

6711 An enhancement to the export of IFC files has been implemented. Several recently
deprecated IFC objects are no longer output when a SAP2000 model is exported. Line and
area objects are no longer exported to the architectural coordination view as
IfcColumnStandardCase, IfcBeamStandardCase, IfcMemberStandardCase,
IfcWallStandardCase, IfcSlabStandardCase objects and are exported as IfcColumn, IfcBeam,
IfcMember, IfcWall, or IfcSlab objects because the "standard case" subtypes of these objects
have been deprecated in IFC 4x1. However, all the "standard case" subtypes of these objects
are still imported from IFC files when present. Section properties with a trapezoidal type are
now exported as IfcArbitraryClosedProfileDef sections instead of IfcTrapeziumProfileDef
sections because IfcTrapeziumProfileDef has been deprecated in IFC 4x3. Note that
IfcTrapeziumProfileDef sections were never imported.

6719 Several related enhancements to the export of frame section properties to IFC were
implemented. (1) Several frame section property types not previously exported are now
exported. These include: concrete precast I, concrete precast U, concrete precast super-tee,
cold formed C, cold formed Z, cold formed hat, cold formed tee, cold formed angle, cold
form box, and cold formed pipe. Previously these profiles were exported as generic
IfcProfileDef objects with a name matching the SAP2000 section name. (2) Angle sections
with different horizontal and vertical leg thicknesses are now exported as
IfcArbitraryClosedProfileDef objects. Previously they were exported as IfcLShapedProfileDef
with a leg thickness equal to the average of the horizontal and vertical leg thicknesses. (3)
Angle section fillet radii, if defined, are exported.

9024 An enhancement to the import and export of IFC files has been implemented. SAP2000
mirrored frame objects are now exported to IFC2x3 with an IfcDerivedProfileDef that refers
to an IfcCartesianTransformationOperator2D specifying a mirror operation and exported to
IFC4 with an IfcMirroredProfileDef section. Conversely IFC architectural objects and
structural analysis objects whose section is an IfcDerivedProfileDef that refers to an
IfcCartesianTransformationOperator2D specifying a mirror operation or an
IfcMirroredProfileDef are now imported as mirrored frame objects.

Installation and Licensing
Enhancements Implemented
* Ticket Description

9007 The version number has been changed to v24.2.0 for a new intermediate release.

Results Display and Output
Enhancements Implemented
* Ticket Description

9268 A change has been made to not display vehicles when animating the deformed shape of
multi-step results on screen. The vehicles were making it difficult to review results on
screen. Vehicle visualization is still available when creating a video using the File > Create
Video > Create Multi-step Animation Video command.

User Interface
Enhancements Implemented
* Ticket Description

8225 An enhancement has been made to the user interface to speed up display and editing of
time-history, response-spectrum, steady-state, and power-spectral-density functions with
many (e.g., more than tens of thousands) data points.
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Analysis
Incidents Resolved
* Ticket Description

8626 An incident was resolved where the forces reported in a Fiber P-M2-M3 frame hinge could
be out of equilibrium with the forces reported in the frame element that contained the
hinge for nonlinear static, staged-construction, and direct-integration time-history load
cases when P-Delta geometric nonlinearity was considered in the load case. The error was
generally small in practical structural models, and was most pronounced in simple, statically-
determinate models subject to large load increments and exhibiting significant axial
nonlinearity in the fiber hinge. The error was reduced by applying the load in smaller
increments. This issue only affected hinges modeled in elements, not hinges model in links
(Analyze menu > Analysis Model for Nonlinear Hinges). Models run in previous versions may
exhibit minor changes in convergence behavior due to this change, especially in sensitive
models with significant hinge nonlinear behavior.

* 9198 An incident was resolved where the analysis model was not properly cleared from the
memory and disk (.MSH file) when unlocking a model with results, and therefore subsequent
actions to remove previously defined load patterns could corrupt one or more load cases,
preventing them from being run. This only affected models where load patterns were
deleted after unlocking the model or creating the analysis model. Only the load-case
definitions were affected. Models that were reopened after being unlocked were not
affected. Locked models with results were not affected, even if the load-case definitions
were changed on the locked model. This error only affected v24.1.0.

API
Incidents Resolved
* Ticket Description

7681 An incident was resolved for the Application Programming Interface (API) where the
functions FrameObj.GetElm and CableObj.GetElm were returning a nonzero error value
when called for objects with none/null properties assigned.

8208 Documentation for the Application Programming Interface (API) has been updated to
correct the signature of the function (procedure) cDatabaseTables.ShowTablesInExcel, and
now includes a full VBA example.

Data Files
Incidents Resolved
* Ticket Description

9095 An incident was resolved where importing a model containing a wave load pattern would
reverse the 'Include Bouyant Loads' option on the wave load pattern definition. Results
agreed with the model as imported.

Database Tables
Incidents Resolved
* Ticket Description

8441 An incident was resolved where an error could be generated when using the interactive
database to modify the "Case - Steady State 6 - Constant Damping" or the "Case - Steady
State 7 - Interpolated Damping" tables. When this happened an error message was
presented and the changes were not applied.

9197 An incident was resolved where the load combinations specified in a database-table named
set were not implemented as expected in the database-table named sets specified to be
automatically output after analysis.
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Design – Cold Formed Frame
Incidents Resolved
* Ticket Description

9320 An incident was resolved for the Eurocode 3 1-3 2006 cold-formed steel frame design code
in which the calculation of the elastic critical moment, Mcr, was missing the square in the
term (KLTB/kw)^2. Previously, in common cases, this resulted in a slightly higher estimate of
the global buckling moment capacity and the design was marginally unconservative. This
affected all cross sections except for the box, pipe, rectangular, and circular shapes whose
lateral-torsional buckling effects are not considered.

Design – Concrete Frame
Incidents Resolved
* Ticket Description

6705 An incident was resolved for steel, cold-formed steel, and aluminum frame design where
assigning a nonprismatic frame section as a design overwrite could cause the design to fail
or an abnormal termination of the software. Now assigning a nonprismatic section as a
design section is not allowed, and if one is detected during design time, it will be ignored
and the analysis section property will be used instead. If it is intended to use a nonprismatic
section for design, then it should be assigned to the member as the analysis section, not as a
design overwrite.

9058 An incident has been resolved in the Russian concrete frame design code SP 63.13330.2011,
in which case, the “Snow Load Duration Factor” preference did not affect the calculation of
long-term moment Ml1 in strength calculation. The total load moment was correct. This
affects the eta factor calculation as it affects the PhiL, Kb, D, and Ncr calculations (SP63
8.1.15).

* 9073 An incident was resolved for the concrete frame design code ACI 318-19 where the potential
plastic zone was not identified correctly at the right (J) end of the beam while the potential
plastic zone was identified correctly at the left (I) end of the beam per ACI 318-19 18.6.4.1.
This caused the design to not set phi*Vc to zero at the right end of the beam if the capacity
shear Vp is more than half of the total design shear, which was incorrect for Special moment
frames per ACI 318-19 18.6.5.2. There was no error if the frame type was NonSeismic,
Ordinary, or Intermediate. This issue was introduced in SAP2000 v22.2.1 when ACI 318-19
code was introduced. Results for affected models in v22.2.1 to v24.1.0 could have been
unconservative.

9252 An incident was resolved for the Indian IS 456:2000 concrete frame design code to remove
the Consider Torsion option from the preference and overwrites forms, as well as from the
interactive database tables and the API functions. The design will always consider the effects
of torsion for beams, but not for columns or braces. This option had no effect on the IS
456:2000 design in previous versions, so there is no change in the design results.

Design – Concrete Shell
Incidents Resolved
* Ticket Description
* 9061 An incident has been resolved where the following sequence of actions in the graphical user

interface could cause an abnormal termination of the software: (1) In one model window,
display concrete shell design results, (2) Switch to a different model window and display
results of any type, then (3) Switch back to the first model window and attempt to right-click
on an area element to see a detailed plot of the concrete shell design contours.
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* Ticket Description
9098 An incident has been resolved for the Eurocode 2-2004 concrete shell design result data

table. Previously, the table showed max and min rows for load combinations that contained
response spectrum, steady state, power spectral density, or multi-step (such as response
history) load cases, and the combo display option was set to envelope. This was inconsistent
with combinations of other combinations which only presented the max result. Now only
the max row of design results is shown for all load combinations when the combo display
option is set to envelope. Similar behavior is exhibited for individual load cases that
represent enveloped response. Multiple rows are shown only when step-by-step or
correspondence results are requested, when applicable.

Design – Steel Frame
Incidents Resolved
* Ticket Description

5881 An incident was resolved for steel frame design codes "Eurocode 3-2005" and "Italian NTC
2018" where the design did not correctly separate the seismic forces from the nonseismic
forces for load combinations where snow load or temperature load coexisted with seismic
load, in addition to any dead and live load. Dead load and live load forces are always
correctly taken as nonseismic, and the seismic load forces were correctly taken as seismic,
but the forces from the snow load and temperature load were also taken as seismic. This
resulted in an error while calculating the design forces for amplified forces per EC8 6.6.3(1)P,
Eqn. 6.6 (N_Ed = N_Ed,G + 1.1 * Gamma_ov * N_Ed,S, and so on for M_Ed and V_Ed). This
was not a concern for load combinations that did not mix seismic load with snow or
temperature load. The results for affected load combinations were conservative.

7466 An incident was resolved where null lines, null areas and null solids were being included
when lateral supports for frames were being traced. This affected the unbraced-length
calculations of frame members for design purposes. The calculated unbraced length was
being reported in the design report and the error was obvious.

7520 An incident was resolved for steel frame design codes "Chinese 2010" and "Chinese 2018" to
improve the effective-length factor calculation for columns for the case where the beams
framing into the columns are fixed at the far end. The previous Mue factors were slightly
conservative for sway columns, while for non-sway columns the previous Mue factors were
slightly unconservative.

8548 An incident was resolved where rotational restraints, when not specified for all three
rotational degrees-of-freedom, may not have been recognized as representing fixed joints in
expected directions for calculating the frame K-Factors used in some designs. When this
happened, the error in K-factors was obvious. No analysis results were affected. The K-
factors will still need to be checked and possibly overwritten with appropriate values if the
restraint directions are at an angle to the principal directions of the frame member. The
need for K-factors can be avoided by using direct design methods allowed in some codes.

8571 An incident was resolved for steel frame design codes "Eurocode 3-2005" and "Italian NTC
2018" where the design used the (EN 1993-6 Annex A) equation instead of the EC3 6.3.3(4)-
6.62 equation in the check for the combined effect of axial compression and bending even in
the absence of torsion. The EN 1993-6 Annex A equation is applicable only in the presence of
torsion. The resulting PMM ratio was slightly conservative, and the difference was generally
insignificant.

* 8684 An incident was resolved for the Italian NTC 2008 and NTC 2018 steel frame design codes
where the P-M-M Interaction Ratios reported for fully-braced members could be incorrect
when "Method A" or "Method Both" were selected for "Method Used for Buckling in P-M-
M" in the design preferences. For fully-braced members, the equivalent moments were
obtained from the previously designed member that was not fully braced, hence the results
reported for affected members could be reported differently on the display, in the design
details, and in the tables, depending on the order in which the members were designed.
Affected results could be conservative or unconservative. Models using "Method B" were
not affected. Models with fully-braced steel members designed using the NTC 2008 or NTC
2018 code with "Method A" or "Method Both" should be redesigned with the new version.
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* Ticket Description
* 8983 An incident was resolved for steel frame design where the link lengths for eccentric braced

frames (EBF) could be incorrect when a model is created or opened in the same SAP2000
instance where another model containing EBFs was previously opened and designed. In this
situation the length of the links were incorrectly used from the previously opened model
instead of determining the link lengths for the newly created/opened model. This affected
all steel frame design codes that perform design for EBFs.

9034 An incident was resolved for the Eurocode 3-2005, Italian NTC 2008, and Italian NTC 2018
steel frame design codes in which the calculation of the elastic critical moment, Mcr, was
missing the square in the term (KLT/kw)^2. Previously, in common cases, it resulted in a
slightly higher estimate of the global buckling moment capacity and the design being
marginally unconservative. This affected all cross sections except for the box, pipe,
rectangular, and circular shapes whose lateral-torsional buckling effects are not considered.

9066 An incident has been resolved for the Italian NTC 2008 and NTC 2018 steel frame design
codes where now the coefficient "C1" has been renamed to "Psi" to be consistent with the
design codes.

* 9224 An incident was resolved for steel frame design code AISC 360-16 where the torsional
capacity of box sections was calculated incorrectly when the web and flange thicknesses
were different. The calculated phi*Tn was higher (unconservative) when the thickness of the
web was smaller than the thickness of the flange. When the thickness of the web was larger
than the thickness of the flange, the calculation of phi*Tn was correct.

9242 An incident was resolved for steel frame design codes "AISC 360-16" and "AISC 360-10"
when using OCBF where the design reported, "Section is not seismically compact for
moderately ductile members (AISC 341-16 E3.4a, 5.2b, Table I-8-1)" instead of "Section is
not seismically compact for highly ductile members (AISC 341-16 F1.5a, D1.1, Table D1.1)"
for brace members.

9258 An incident was resolved where the unbraced length for lateral-torsional buckling (LTB) did
not work properly for the lateral brace points applied on top or bottom using the command
Design > Lateral Bracing. This affected steel frame design for codes Eurocode 2-2004 and
NTC 2008-2018; cold-formed steel design for codes AISI-16 and Eurocode 3 1-3 2006; and
aluminum frame design for codes AA 2015-2020 and EN 1999:2007. In addition, the brace
points for flexural buckling about major and minor axes, as well as for the LTB, were
combined for the bracing conditions specified in the overwrites or using Design > Lateral
Bracing with the internal brace points, which are determined by the connection among
frame members without defined joints at the intersections. Now, the brace points for
lateral-torsional buckling (LTB) assigned using Design > Lateral Bracing will check for top or
bottom properly. The following priority order will now be followed: (1.) The unbraced length
(and resulting brace locations) defined by the overwrites will take the first priority; (2.) If
there are no unbraced-length overwrites, any brace points specified using Design > Lateral
Bracing will be considered next; (3) If no overwrites or brace points are explicitly specified,
brace points will be internally determined by the connections between frame members. By
specifying a ratio for an unbraced length type using the overwrites, the number of brace
points will be internally determined, and the brace point locations will be arranged such that
they are symmetric about the center line of the member and the distance between the
adjacent braced points is the specified unbraced length (L). For the brace points closest to
the ends of the frame element, they will be placed at a distance (L_end) that is always less
than or equal to the specified unbraced length L (i.e., L_end <= L). However, for the design
stations that are within this L_end, the brace points are the end joint of the element and the
other point is at the location that is of the unbraced length L away from the end joint. These
brace points are used only to determine the shape of the moment diagram needed to
compute intermediate design parameters. The unbraced length L is still used to calculate the
axial compression and moment capacity under consideration of global buckling.
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Drafting and Editing
Incidents Resolved
* Ticket Description

8908 An incident was resolved where a frame section assignment applied by using the Copy
Assigns and Paste Assigns operations could be lost (i.e., revert to the frame section assigned
before the Paste Assigns operation) after running the analysis. This only occurred if a steel
frame design had been run before the Copy and Paste operations were performed.

External Import and Export
Incidents Resolved
* Ticket Description

2140 An incident was resolved where the orientation of double-angle sections exported to IFC
was incorrectly rotated by 180 degrees.

8661 Two related incidents affecting the export of models to IFC files were resolved. (1) Frame
objects with a cardinal point other than 5, the middle-center of the section, were exported
to Architectural Coordination View and Structural Analysis View IFC 4 files with contradictory
information. Their cardinal point was properly specified in their associated
IfcMaterialProfileSetUsage object but their "Body" IfcShapeRepresentation attribute did not
reflect the position cardinal point. This incident did not affect export to IFC 2x3 files. All
versions of SAP2000 capable of exporting to IFC files were affected. (2) Beams were
exported with their "Axis" IfcShapeRepresentation attribute oriented parallel to their
SAP2000 axis 2 instead of axis 1. This incident affected export to Architectural Coordination
View and Structural Analysis View IFC 2x3 and IFC4 files. Again, all versions of SAP2000
capable of exporting to IFC files were affected.

9036 An incident was resolved that addressed four issues affecting the import of DXF files: (1.)
3DFace objects were not imported; (2.) Objects were not imported if the DXF file contained
any lightweight polyline objects, and (3.) Requested axes rotations were not applied. When
these issues occurred, the effects were obvious, and the results agreed with the model as
imported. (4.) DXF files could not be imported into an already open SAP2000 model. These
issues affected SAP2000 v24.1.0. only. Note that lightweight polylines were not imported in
earlier versions of SAP2000, though they didn't affect the import of other objects.

9047 An incident affecting the import of circles and arcs from DXF files was resolved. When the
user selected a SAP200 "Global Up" direction other than the DXF Z axis, circles and arcs were
imported in incorrect locations. When this occurred, the error was obvious and the results
agreed with the model. Rotating the DXF file in the originating CAD program and aligning the
Z axis with the desired "Global Up" direction avoided the problem. All versions of SAP2000
capable of importing circles and arcs from DXF file were affected.

9298 An incident affecting the import of CIS/2 STEP files was resolved in which some STEP
"externally bound" entity definitions incorrectly combined sub-definitions and data defined
outside of these sub-definitions. When the user attempted to import such a file, SAP2000
became unresponsive for a long while and eventually displayed an error message referring
the user to an error file in which the problematic entities were identified but the syntax
error itself was left unexplained and instead listed as a "bad allocation". When this occurred,
no model was created. All versions of SAP2000 capable of importing CIS/2 files were
affected. A related enhancement has been implemented. SAP2000 can now import CIS/2
files in which the magnitudes of vectors are specified with the "LENGTH_MEASURE"
keyword, even though this keyword is unnecessary and normally omitted.

Graphics
Incidents Resolved
* Ticket Description

8313 An incident was resolved where the graphical display of frame releases was not displaying
the release at the I-end if the frame contained a release at the J-end and neither M2 nor M3
was released at both ends. This was a graphical display issue only.
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* Ticket Description
8984 An incident was resolved where the extruded display of cold-formed angle sections were

shown as cold-formed channel (C) sections when the "Show Frame Section Thickness in
Extruded View" option was unchecked on the Display Options form.

9043 An incident was resolved where design results, such as reinforcement ratios, that were
displayed as text on frame objects could overlap the frame object itself. This issue only
affected Classical (GDI+) graphics mode in v24.1.0.

9151 An incident was resolved the size of text displayed in the graphical user interface could be
scaled incorrectly in Classical (GDI+) graphics mode compared to DirectX mode. This affected
images exported to EMF files, since these are based on Classical graphics mode.

Results Display and Output
Incidents Resolved
* Ticket Description

7571 An incident was resolved where plotting displacement results from different load cases in
different windows at the same time, and then changing view directions in the windows,
could lead to incorrect results being displayed. This only affected the displacement display
as described here, not tabulated results nor any other type of results.

8314 An incident was resolved where the units listed in the footer of the printed graphics for
various plot forms were incorrect. The plotted data and axis labels were in the current
display units while the listed units in the footer were always database units, instead of the
current display units. Note that the database units are those in effect when the model is first
created or imported, and that are also used for analysis. This affected the Display Plot
Function Traces, Hinge Results, Fiber Results, Pushover Curve, Spectra Comparison for Soil-
Structure Interaction Effects, Material Stress-Strain Curve Plot, and Material Property Time
Dependence Plot forms.

8389 An incident was resolved where the values displayed for plots of displacement contours on
solid objects were not correct for units other than database units. For reference, database
units are those in effect when the model is first created or imported, and these units are
shown in the analysis .LOG file.

* 8544 An incident was resolved where the advanced report writer could experience an abnormal
termination when a previously saved named report was opened and an attempt was made
to display a table in it.

9063 An incident has been resolved for the concrete shell design where the Save/Show Named
Display commands did not work for concrete shell design results. This was a display issue
only and did not affect the design results when displayed or tabulated.

9096 An incident was resolved where the deformed shape option did not work when displaying
shell stresses. This issue only affected v24.1.0. Results were not affected.

9100 An incident was resolved where, when scrolling over the graphical display of the deformed
shape, the values of joint displacement shown at the mouse cursor were given in the global
coordinate system (or the selected user coordinate system) rather than in the joint local
coordinate system, even though they were labelled as being for U1, U2, ..., R3. No other
results were affected. In particular, values shown when right-clicking on the joint were
correctly given in the joint local coordinate system. This issue only affected v24.1.0. Previous
versions were not affected.

* 9204 An incident was resolved where the software could terminate abnormally when attempting
to display Plane, Asolid, Solid, or Soil stress plots in a newly added model window when the
same type of stress plots were already being displayed in an existing model window. This
was a display issue only, and no results were affected.

9348 An incident was resolved where the calculation of the ASCE 41-13 NSP target displacement
for static pushover plots (Display menu>Static Pushover Curve) would sometimes fail to
produce a result for the case where the pushover curve has a slight stiffening effect in the
small-displacement range. The iterative procedure to determine the target displacement has
been improved to handle this case. However, curves that stiffen significantly are outside of
the scope of the specification, and may still fail to produce a target displacement, as
expected.



SAP2000 v24.2.0 ISO #RELSAP2420     14-Feb-2023 Page 10 of 10

Structural Model
Incidents Resolved
* Ticket Description
* 9020 An incident was resolved where program-calculated section modulus values about the 3-axis

were incorrect for user-defined double angle sections. Essentially, the section modulus
values for the top and bottom fibers were flipped. The issue only affected versions 24.0.0
and v24.1.0 of the software. Imported double-angle sections were not affected. Models
opened or imported in the the new version will be automatically corrected. Any steel frame
design previously performed using affected sections should be re-run using the latest
version. In most cases, the design will not be affected because the smaller of the two section
moduli would be used.

9038 An incident was resolved where drawn section cut on screen results were different in some
cases when saved as quad section cuts. The saved quad section cut results were in error
when edge constraints were present. If edge constraints were cut they were being included
in the results even if the area element they belonged too were not to be included in the
results.

9295 An issue was resolved where Parametric P-M2-M3 hinges created by assigning an auto hinge
to a frame object (Assign menu > Frame > Hinges) may have had invalid yield-surface or
force-deformation parameters. When this issue occurred, the model was unable to run due
to the invalid parameters.


